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1.1,2,3 
 

Launch the Application from the 
desktop (Desktop icon). A signing 
pencil. 
 
 

Start Menu 
 
Start=>All Programs=>Datarizer 
Inc=>Datarizer 
eSignature=>Datarizer eSignature 
 

 
Datarizer eSignature Logo 
 

 
 
 

 
 
 
 
 
 
 
 
 
 

 

Application Overview 
 
1.1  What is Datarizer eSignature? 
 
Datarizer eSignature is a software application (or system) that enables online 
signing of PDF documents across the internet. It is native application with a 
small client and big server arrangement. It is also a cloud application with client 
side software for better user experience and rich interactive User Interface (UI). 
It was designed with a simple concept in mind to mimic traditional signing on 
paper to make it simple and user-friendly. Inexplicable security issues are coded 
into the software and the user does not have to worry about them, such as 
Private Key, Public keys and individual documents passwords etc. Datarizer 
eSignature is affordable, everyone should be able to sign documents. Only PDF 
documents can be signed with Datarizer eSignature. 
 
1.2  Why PDF Documents? 
 
PDF stands for Portable Document Format. PDF was in existence since 1991 
and had stood the software compatibility test of time across different platforms 
until to date. It was outlined by Adobe System, cofounder “John Warnock”. The 
major problem that is solved was document compatibility and quality across 
different platforms. 
 
Applications compatibility and their associated files is still a major concern today. 
Software vendors continue to upgrade and develop new applications and in time 
compatibility is lost with older versions. This is a huge concern to electronic 
signing of documents, because legal documents must be kept and be accessible 
for many years. 
 
Datarizer eSignature will keep documents for 25 years before permanent 
deletion with consultation with the originator. 
 
 
1.3  How is it different from other electronic and digital signature 
software? 
 
Datarizer eSignature blends both electronic and digital nature of signatures into 
one, without pushing the complexities to the user. The user need not worry 
about Private/Public keys and SSL. They are all taken care of differently in code. 
The weakest link in any secure system is always the user (the human element). 
See the next sub-section for more insight on security. 
 
It complies with the KISS principle, it is simple, user-friendly and affordable to all. 
Signed document does not need to be transmitted through emails (SMTP) as 
this transmission takes place in the system. 
 
Datarizer eSignature serves only the copies and never the original document to 
prevent tampering with the document. The original document is broken down 
and kept in the database and used together with all the signatures and device 
used to sign to form the #hash or digital nature of the final document. This digital 
nature of the document cannot be forged. When a document is validated, this 
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1.3 
 

Datarizer eSignature Logo 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

digital nature is used to check document that is being validated. If the document 
was changed in anyway, it will never validate true. Validation must be done 
using the Datarizer eSignature as it contains the original document with the 
original digital nature. The safest and secure place to store data or documents is 
in the database. 
 
Document copies can only be served to the devices (computer, laptop etc) that 
are in the workflow as stipulated originally when the document was uploaded. 
NB: The document can never be listed, appear or served to the device which is 
not in the document workflow.  
 
Datarizer eSignature is completely independent from Adobe Reader application. 
The technology that is used to sign the documents is on a file level and not on 
application level unlike the other electronic signature softwares. This prevents 
any compatibility issues that may arise in future. This problem occurred recently 
during the development when Adobe Reader was part of the Datarizer 
eSignature where Adobe Reader version XI (eleven, 11) failed to view PDF 
documents. The entire Datarizer eSignature design had to be changed to work 
around these compatibility issues. One can never be sure about what software 
vendors will get up to in future. 
 
Datarizer eSignature can be used immediately on a corporate level or individual 
level. No integration is necessary. Download the software and start signing PDF 
documents.  
 
If your device is stolen, call Datarizer Inc. and have all your documents linked to 
the new device. Your stolen device will be deactivated and wait for thief to come 
back and be caught. Even if the device is reformatted and reloaded with new 
OS, the thief will still be caught because the device hardware was not changed. 
This is the part that improves the security of the application (or system). 
 
No peripheral are necessary such as expensive signing pads and pointers or 
pens. Use what is already available such as Paint application and scanners. 
 
Datarizer eSignature offers the same freedom that one currently enjoys with 
PDF documents. Once the Document copy is served to the user, the user can do 
as they wish, that is, send it to whoever by email, delete it, archive it, change it, 
comment it. BUT, remember, any changes to the document will be validated 
false, meaning the document copy is no longer valid because of changes made. 
 
Save time and money. Documents can be transmitted, signed within minutes 
across the planet, safely and securely. 
 
All software updates are done online, meaning bugs and upgrades can be done 
quickly and efficiently. The fix or upgrade is as close as your next launch of the 
application. What a quick turnaround time. 
 
It is 100% paperless. The option to print is still available but not needed.  
 
Datarizer eSignature does not sign PDF documents that have been locked by a 
password for modification as this constitutes unethical behavior. We shall leave 
those documents untouched. 
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1.4 
SSL 

 

 
www.comodo.com 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.4  Authentication security formula 
 
The authentication security formula can best be presented mathematically as:- 
 
Security  = Function �(Device, Account Number, Password, SSL, Visual 
eSignature, Document Digital Nature (#hash function algorithm), Validation code 
Technology, 3 times login failure lockout, 30 days password expiry) 
 
Datarizer eSignature also uses COMODO for an increased security online. 
 
Datarizer eSignature uses the device that was used to sign in the security 
formula to limit the weakness of the user on security matters. For instance, if the 
login credentials of the user were hacked or phished, the Hacker will still not be 
able to log in the system despite applying the correct credentials. A message 
shown in figure 1 will be displayed. 
 

 
Figure 1 – Correct Login Credentials and incorrect Device. 
 
Figure 2 below illustrates if the user entered incorrect password while still on the 
incorrect device, then, access is denied and the next level of authentication is 
ignored, unlike in figure 1 above. 
 

 
Figure 2 – Incorrect Login credentials and incorrect Device. 
 
Figure 3 below indicates when the user types the Account Number which does 
not exist.  Datarizer eSignature guards the user in every way possible. If the user 
fails to log in three time, the user will be completely locked out of the system. 
This can be corrected by calling Datarizer Inc. to reset you. 
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1.4 
 
 
 
 
 
 
 
 
 

 
Figure 3 – Account does not exist. 
 
The authentication process goes through various levels to ensure that the user is 
authenticated correctly and keep the bad guys out. 
 
Secure Socket Layer (SSL) technology is used to connect the client and server 
devices through the security pipe. 
 
Anyone can validate any document, no login credentials are required, all you 
need is to launch the application and browse the PDF document you want to 
validate. If the document is valid, Datarizer eSignature will provide the Document 
Number, BUT, it will never serve the document copy to the strange device which 
is not in the workflow. Why is this? Because after many years another user might 
stumble across an electronic document which was signed using the Datarizer 
eSignature and may not be sure whether this document is valid or not. The user 
can validate this document without login into the system to ensure that the copy 
is intact and not tempered with. 
 
A document that carries password and other security features in itself is a bit 
risky and many things can happen to it. It validates against itself and if it gets 
corrupted though the transitions and transmissions, then what?? Datarizer 
eSignature does not work in this manner. It keeps the original copy intact inside 
the database, away from possible abuse. 
 
The only way to keep data and documents/files secure is inside the database 
and nowhere else. The Database security permission should be reduced to the 
absolute minimum.  
 
The Digital nature of the document is the complex mathematical computation 
algorithm that is done on the final document to produce a hash number which is 
so unique and cannot be reproduced again by using a different document. 

 
Private Key �  Function�(Device, Login Credentials, Document Digital Nature, 
SSL) 
Public Key �  Function�(Device, Document Digital Nature, SSL) 
 
It is a security risk to explain beyond this level. This information is adequate to 
ensure that security has been taken care of to a reasonable extent. 
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Definitions and Abbreviations  
 
Application/System 
Both words are used interchangeably in Datarizer eSignature. For simplicity they both 
mean application. However, system is much complex and bigger than application 
because of many devices connected together through the internet with big back end 
RDBMS. 
 
Device 
Device could be a computer Laptop, Notebook, Mobile smart phone, Desktop 
computer, Mac, iPad, Tablet, Surface. Any machine consisting of a processor, hard 
drive, screen and input devices (such as keyboard) and is capable of running this 
application as per the system requirements. 
(NB:  In future it will be possible to run Datarizer eSignature on all devices. Currently it 
only runs on Windows operating platform.) 
 
Electronic Signature and Digital Signature 
See general legal definitions in the next Section 3. 
 
Device Stamp 
It is a software independent unique code of the device. 
 
Device Signature 
It is a software independent unique serial number of the device. 
 
Validation 
A thorough computation process of looking at a smallest piece of a computer file, one 
by one, using a digital magnifying glass to ensure that the two files are exact match 
beyond reasonable doubt. 
 
Authentication 
A computation process or means of identifying users and devices, and verifying their 
eligibility before access is given into the system or application on the correct devices. 
 
TRANS 
It is verb and also a document status, meaning to change a document into a state 
where no further changes are allowed. This status “TRANS” gives a document its 
original value. The document in this state cannot be signed any further. NB:  It is 
important that all the signatories sign the document before it is TRANS’d or else, no 
more signatures will be allowed. The last signatory must check if all have signed 
before clicking the “TRANS” button on the toolbar menu. 
 
SSL: Cryptography Secure Socket Layer technology 
 
UI: User Interface 
 
PDF: Portable Document Format 
 
RDBMS: Relational Database Management System. Database 

system such as Oracles, MYSQL, Postgre, MS SQL 
Server, DB2 etc. 

 
KISS Keep It Simple Stupid principle. 
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Legality of eSignatures  
 
The digital age came along with an increase in digital information and in other 
cases it is no longer possible to sign using the traditional pen and paper. Things 
are happening quite fast. Imagine having to print a form, fill it in, sign it, scan it 
back into the computer and send it by email. Sometimes, the scan copy is not 
accepted, which means the original copy must be posted or transported where it is 
required. It cost time and money to do transact in this manner. Imagine buying 
shares online and receiving and signing the contract online immediately. This is 
efficient. 
 
Governments all over the world have realized the role that electronic and digital 
signatures plays in the digital or information age. There is no turning back. 
 
Electronic signature and digital signatures are legal in many countries, even 
though, not all countries have proper legislation in place to control the boundaries 
of electronic and digital signatures. 
 
What is the difference between Electronic and Digit al signatures? 
 
Electronic Signatures 
An electronic signature  is a signature that consists visual form on a screen or 
print, characterized by a digital form incorporated in and attached to or associated 
with an electronic document. 
A secure electronic signature is as an electronic signature that:- 
·  is unique to the person making the signature; 
·  the technology or process used to make the signature is under the sole 

control of the person making the signature; 
·  the technology or process can be used to identify the person using the 

technology or process; and 
·  the electronic signature can be linked with an electronic document in such a 

way that it can be used to determine whether the electronic document has 
been changed since the electronic signature was incorporated in, attached to 
or associated with the electronic document. 

 
Digital Signatures 
A digital signature  is a mathematical scheme for demonstrating the authenticity of 
a digital message or document. A valid digital signature gives a recipient reason to 
believe that the message was created by a known sender, such that the sender 
cannot deny having sent the message (authentication and non-repudiation) and 
that the message was not altered in transit (integrity). Digital signatures are 
commonly used for software distribution, financial transactions, and in other cases 
where it is important to detect forgery or tampering. It involves the Cryptography 
technology. This signature does not have a visual form. 
 
 
The concept of a legal Electronic/Digital signature  
Many countries retain the following general rules to govern the use of electronic 
and digital signatures.  
 

1. Intent to sign. The signature is valid only if the signatory had the intent to 
sign. 

2. The signatory MUST do the signing personally.  
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3. Notarization. It should be possible to certify, attest or authenticate that the 
signature or the entire document is legitimate. 

4. The signature or the electronically/digitally signed document should keep 
an associated record to reflect the electronic process that was used to sign 
it. 

5. Document retention. The signed documents (records) should be kept safe 
for a reasonable time period and the ability to reproduce them at a later 
stage to all concerned parties. 

6. The capability of the electronic/digital process to prevent or expose the 
document forgery should this happen. 

 
If the electronic or digital signature process covers the above, it will be adequate to 
ensure a safe and reliable usage of electronic or digital signatures. 
 
It is important to note that, the electronic/digital process attempts to mimic or better 
the traditional ink on paper process which is simple enough for the average John 
Doe. The average John Doe should not be bombarded by complex computational 
algorithms to ensure the implementation of the above six points. The electronic 
digital process should use the complex computational algorithm information to 
apply to the six points and provide simplistic information that can be understood by 
the average John Doe.  
  
 
The future of Electronic Signatures 
 
Countries are busy putting or perfecting their legislation to govern the use of 
electronic/digital signatures. Amongst others are, just to mention a few:- 
 

·  South Africa – Electronic Communication and Transactions Act 25 of 2002. 
·  United States – Electronic Signature in Global and National Commerce Act 

of 2000. 
·  United States – Uniform Electronic Transaction Act or 1999 (UETA). 
·  United Kingdom – UK Electronic Communication Act of 2000. 
·  United Nations - UNCITRAL Model Law on Electronic Commerce of 1996. 

 
 
The amount of electronic transactions and electronic information has vastly 
increased to an extent that this cannot be ignored but to be made better to work in 
all electronic transactional scenarios. Every country is working on to adopt some 
kind of electronic signature law. 
 
All the software vendors supplying the electronic signature software must ultimately 
come together to produce one acceptable software that is acceptable globally by 
all. 
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Application User Interface (UI)  
 
The User Interface is simple and user-friendly. Signing a document is four clicks 
away. 

1. Indicate whether you are signing a “New” or a “Signed” document. 
2. Select to “Sign All Pages” or to “Sign Last Page”. 
3. Select or Type your signing capacity. 
4. Click “Sign Document” button. 

That is all to signing a document using Datarizer eSignature software. See figure 4 
below. 
 

 
Figure 4 – Datarizer eSignature main screen 
 
The User is partially authenticated by the Device even before user logs into the 
application or system. The access is limited but the correct documents are served 
based on the document workflow. The user can further authenticate self to get full 
access into the system. See figure5 Below. 
 

 
Figure 5 – Login screen 

Top list – new documents 

Bottom list – signed documents 
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Figure 6 – Device Stamp and Device Signature 
 
Figure 6 above shows the Device Stamp and Device Signature of a particular 
unique machine or device. This is unique and there is no other device with the 
same numbers or codes. This is the unique digital pen that is used to sign the 
document. Suppose the exact document is signed by two different devices, the two 
documents will not be the same digitally. In the algorithm function, the Device 
Stamp and Device signature serves more or less the same purpose as Private Key 
and Public Key functions. This is all coded in the application software. 
 
The Device Stamp and Device Signature are not software dependant but hardware 
dependant. Even if the software is changed, these two codes will remain the same. 
 

 
Figure 7 – A Visual Electronic Signature 
 
The visual Electronic Signature shown above in figure 7 will form part of the 
document with its digital form to make up a unique document with an overall unique 
digital form that includes the device that was used to sign the document. For 
instance, if Document Number 101 was signed by this signature, same device and 
same signatory. If the same document is recreated as Document Number 102, 
signed by the same device and signatory few milliseconds apart. Visually, 
Documents 101 and 102 will be the same however, digitally, documents 101 and 
102 are two distinct documents. They are not the same document and the system 
will validate them as two different documents. What the human eye cannot see 
visually, the system detects digitally. This makes the Datarizer eSignature far better 
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than the traditional pen on paper signature. 
 

 
Figure 8 – User details 
 

 
Figure 9 – PDF Document before it is signed 
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Figure 10 – PDF Document after it was signed 
 
Figure 9 and 10 above shows an unsigned and a signed PDF documents 
respectively. All the 114 pages were signed. 
 

 
Figure 11 – Zoomed-in details of the signature 
 
There is a transcript written vertically, along the document on the right hand side of 
the signed document which states  
“Datarizer eSignature 206807587 (Document Number: 127) Page 4”. See figure 10 above. 
 
It is clear that this document was signed using Datarizer eSignature and the 
Document Number is a reference back to the application. 
 
The signature above in figure 11 also contains some useful information such as 
Signing Capacity, Signatory, Designation, Date and Time and the Device that was 
used to sign the document. The visual signature can be made a little artistic than 
shown here. It is possible and increases the digital security features. 
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Menus 
 

 

Datarizer eSignat ure Licence  
 

 
Figure 12 – Software Licence information 
 
The Software Licence number is the same as the Device Stamp code. Immediately 
after downloading the software, you get 30 days trial period, counting from 0 to 30 
days while the Licence is invalid. When your 30 days trial period expires, the 
system locks out and awaits a once off Licence fee payment. The system will 
unlock itself after the Licence fee of R49.00ZAR has been paid at 
www.datarizer.co.za/payments.htm.  See sub-section 9.8 for payment procedure. 
 
This is a once off payment and once paid, the Software Licence becomes valid. 
Use your Licence number (Device Stamp ) as Your Registration Number  when 
making payments. NB: It is case sensitive. When this happens, all the necessary 
instructions will be provided. 
 
If you do not need the software, uninstall it. 
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Menus 
 

 
 

 

 

Datarizer eSignature Service Account  
 

 
Figure 13 – Service Account 
 
Service Account is the same as your Account Number. The user must register to 
have this account. This account is not required if the user does not need full 
access to the application. The Service Account offers full access to the system. 
The user is given 30 Service Days trial period to evaluate the Service Account after 
which it will expire. A service fee of R60.00ZAR must be paid to buy 180 Service 
Days. If the Service Account has expired or Service Days are at 0, the user will not 
be able to login and therefore receives limited access to the services. Payment can 
be done at www.datarizer.co.za/payments.htm. Use your Service Account  as 
Your Registration Number . The system will allow the user to login immediately 
after the service fee payment is done. (Case sensitive). See sub-section 9.8 for 
more payment details. 
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Menus 

 
Document=>Validate 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Data Management  
 

 
Figure 14 – Data Usage 
 
Datarizer eSignature server stores each document for many years despite the 
expiry date stipulated by the Originator of the document. Whenever a document is 
uploaded into the system, the user or Originator must stipulate an expiry date. 
Each document can either have “Live” or “Dead” Document State, meaning all 
document before the expiry date are “Live” and all document after the expiry date 
are “Dead”. Figure 14 above shows Data Usage of all the “Live” documents 
uploaded by the user of the Service Account. 
 
All the “Live” documents will be served to all the users as per the document work 
flow. All the “Dead” documents will be available in the archive and be available 
when the user performs a search. 
 
All the excessive MB (Mega Bytes) beyond the free data storage of 20MB will be 
charged on a monthly basis and consolidated on a yearly basis as per the 
anniversary selected during registration. The invoice will be send once a year 
together with the Data Usage assessment. The Data Usage is well within the 
user’s control because the user selects the document expiry date. See figure 14 
above for more explanation. 
 
How to retrieve a “Dead” document? 
 

1. Perform a search and find the “Dead” document you are looking for. 
2. When you double click on a “Dead” document, you receive a message 

explaining the entire procedure on how to retrieve the “Dead” document. 
See figure 15 below for the full step by step procedure. 

3. A Resuscitation Fee must be paid before a “Dead” document is retrieved 
from archives. 

4. The document becomes accessible immediately after the payment for the 
next 48 hours. During this time the user can make a copy of the document. 

5. Please note that the Document Number and the Device Signature must be 
used as “Your Registration Number” when making a payment. In figure 15 
below, the reference number for the document to be retrieved is indicated 
as “114-206807587” where 114 is the Document Number and 206807587 
is Device Signature. This code must be typed correctly when making a 
payment. Do not forget the dash (-) between these two numbers or codes. 
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Keyboard F2 
 

 
 
 
 
 

 

 
Figure 15 – A “Dead” document retrieval procedure. 
 
The payment must be done at www.datarizer.co.za/payments.htm. As soon as this 
payment is done, go ahead and double click on the document to retrieve it. 
 
 It is important that the users realize that they see the documents that are served 
to them as per the authentication that is done by the Device Stamp as per the 
original document workflow. 
 
The only process that may give you a Document Number that may or may not be 
served to your device is the Validation process. Click Menu “Document=>Validate” 
or press F2 on the keyboard. 
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System Requirements  
 
Datarizer eSignature runs on Microsoft Windows Operating System (OS). 
 

Windows Operating Systems 

 
1. Windows XP 
2. Windows Vista 
3. Windows 7 
4. Windows 8 (???) 

 

System Minimum Disk 
Space RAM Processor 

32 bit 600MB 512MB 1GHz 
64 bit 1.5GB 512MB 1GHz 

 
This application is supported by .NET Framework 4.0 
 
 
Future Developments 
 
Development is underway to bring this application to run on other platforms, such 
as iOS, Mobile Platforms (sambian), Linux etc. Some of the problematic platforms 
will be dealt through HTML and other scripting languages such as JavaScript and 
PHP. The challenge is always to bring the same security features as currently as in 
the Windows platform. Security will not be compromised. 
 
The server side will not be changed with exception of scaling it up to store more 
data. 
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How to? Everything  
 
9.1  Get Security and Certification Authority Infor mation? 
 
Software Certificate was issued by COMODO. https://www.comodo.com 

 
 
The SSL certificate for secure connection between Server and Client machines 
was also issued by COMODO. 
________________________________________________________________ 
 
 
9.2  Register a Service Account? 
 

1. Go to menu “Registration=>How to Register?”. 
2. This menu provides all the necessary details that one needs to register a 

Service Account. See figure 16 below. 
 

 
Figure 16 – Service Account Registration information 
 

3. Click menu ”Registration=>Register”. 
4. Complete all the required details and Click “Save” button. 
5. Please take note that some of the information is optional, complete it or 

leave it out. The Anniversary field will be the month that your Data Usage 
is consolidated for the past 12 months and an assessment sent to you 
with the bill for excess data usage. 
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Figure 17 – Service Account Registration 
 

6. NB: All the future correspondence will be done using the Account 
Number and the email provided in this form. Datarizer will not provide 
any information to any other email address unless it corresponds with 
your Account Number. 

7. That is all to registration and you can use the account fully during your 
trial period of 30 days. No restrictions whatsoever. 

8. You can register more than one Service Account on the same device to 
have different signature details.  

________________________________________________________________ 
 
 
9.3  Create and upload your Electronic Signature? 
 
All you need to create your Electronic Signature is a scanner, a paint brush 
application, pen and white piece of paper. 
 
Signature Dimensions 
 
Your signature should be 2cm X 7cm or 20mm X 70mm. 
 

 
Figure 18 – Electronic Signature dimensions 
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Start Menu=>All Programs=>Accessories 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Follow these steps to create your signature:- 
 

1. Take an A4 size paper and mark out the dimension of 70mm X 20mm. 
2. Sign inside the mark as shown in figure 18 above. 
3. Cut out your signature out with scissors. 
4. Scan the signature image into a PDF. 
5. Open the signature image and set PDF zoom to 100%. 
6. Use the PDF Snapshot tool to select the image and copy to clipboard. 
7. Open the Paint application. Start Menu=>All Programs=>Accessories. 
8. Click menu “Image=>Attributes”. 
9. Set Width = 305 Pixels and Height = 85 Pixels as shown in figure 19 

below. 
 

 
Figure 19 – Paint Brush menu “Image=>Attributes” 

 
10. Click “Ok” button. 
11. Click menu “Edit=>Paste” or “Ctrl + V” on the keyboard to paste. 
12. The signature image should be in paint. Tip: Real size image. Take your 

paper signature and put it on the screen to check. 
13. Save this image as *.jpg or *.tif or *.png. 
14. Click menu “File=>Save As”. Select the suitable file name and ensure 

that “Save as type” is selected as *.jpg or *.tif or *.png. 
15. Click the “Save” button. 
16. Your signature is done and ready to be uploaded. 

 
 

17. Launch Datarizer eSignature application. 
18. Login. 
19. Click menu “Signature=>Update Signature”. 
20. Browse and find your newly created image signature. Select it and Click 

“Ok” button. 
21. Now Click Menu “Signature=>View Signature”. 
22. Your signature is done and ready to be used. 

________________________________________________________________________ 
 
 
9.4  Upload a PDF document? 
 
Uploading a PDF document to be signed is as easy as saving or opening a file. 
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Please follow these steps to upload a document. 
 

1. Log in. 
2. Click menu “Document=>Add New” or click “Add New” on the toolbar. 

 

 
Figure 20 – Select the document to upload 
 

3. Select the document to upload and click “Open” button. See figure 20 
above. 

 

 
Figure 21 – Document Access tab for Signatories 
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4. In the “Document” tab, complete information such as New FileName, 

Reference Number, Document Description and Expiry Date. Change and 
add more information for clarity. Changing is optional. 

5. Select the appropriate Expiry Date as this is important for Document 
State and easy access to the document. It takes longer to access an 
expired document. Expired documents are archived. 

6. Click “Save” button and you will be taken to the next tab, “Document 
Access” as shown in figure 21 above. 

7. Insert Signatories and those (Access only) who are entitled to access a 
document copy. There are three options to insert Device Stamp codes in 
the work flow:- 
a. Select “I am the Signatory” to select yourself (Originator) and click 

the “Add my Device” button, or 
b. “Select from the Contact List” and click “Add Selected” and “Close” 

buttons, or 
c. Select “I have the Device Stamp” and type it in. Click the “Add 

Device Stamp” button to add it to the document work flow. Please 
type the correct Device Stamp. 
(in a or b or c, ensure that either “Signatory” or “Access Only” is 
selected for correct access right in the work flow) 

8. Click “Close”. Take note of the Document Number. 
9. The document is ready to be signed by Signatories as per the document 

work flow. 
 
The devices not listed in this document work flow will not be able to access this 
document whatsoever. Datarizer eSignature will not serve the documents to 
devices not listed in the “Document Access” tab. 
 
NB: Validation is the only process that will reveal the validity of any external 
document and even serve the Document Number, BUT, it will not serve the 
document or list the document details to any device that is not in the work flow.  
________________________________________________________________ 
 
 
9.5  Sign a PDF document? 
 
It takes only four clicks to sign a document. Our previous example in sub-section 
9.4 uploaded a “Document Number 129”. This document will be signed in this sub 
section. Follow the these steps:- 
 

1. Log in. 
2. Select the document to sign in “Documents to be signed” tab. The top 

section list. Take note, there is top and bottom document lists. 
3. There are three selections on the toolbar menu. Refer to figure 22 

below:- 
a. Select “New” if you are signing new document (top list). Always 

select “New” for all documents in the “Documents to be signed” 
tab of the top section. This is the first signature. Select “Signed” if 
you are signing a signed document which is listed at the bottom 
of the “Document to be signed” tab. In case more signatures 
needs to be attached. 

b. Select which pages to sign. Select “Sign All Pages” or “Sign Last 
Page”. Signature will always appear at the bottom of the page. 

c. Select the signing capacity or authority. You can either type it or 
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select from the list. (Authorizer; Approver; Accepted By; Witness; 
Compiler). 

4. Click “Sign Document” button. 
5. The signed document will appear at the bottom list of the “Documents to 

be Signed” tab. 
 

Figure 22 – How to sign a document 
 

6. When all the Signatories have signed the document. The last Signatory 
to sign must click “TRANS” button on the toolbar menu. 

7. The TRANS process will move the document/s from the “Documents to 
be signed” tab (bottom list) to the next tab “All Documents”. This process 
is irreversible. 

8. Document signing is completed. 
 

 
Figure 23 – Document signed message 
 
NB:  Once the “TRANS” button is clicked, no further changes or any signing can 
be done on the document. The document is sealed forever. It is important to note 
that this button is not clicked unless all the signatories have signed the document. 
This could have been coded in but it was left out for a very obvious reason. 
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9.6  Validate a document? 
 
Datarizer eSignature validates all external PDF documents with a reference to 
itself, meaning, if a document was signed using Datarizer eSignature, it can be 
validated to check authenticity of the document. Validation is universal, it can be 
done on any device running Datarizer eSignature. 
 
Validation is: True , means that the external document is the copy of the original 
document in the system and no changes has been made. It is authentic. If a 
document is validated to be true, Datarizer eSignature will serve a Document 
Number and depending on the document work flow, the document may or may 
not be served to the device. If you have a Document Number, you can call the 
document using the document search. If you are not on the correct device the 
document will not be served to the device. 
 
Validation is: False , means that the document does not exist or changes were 
made. The external document copy was not signed using the Datarizer 
eSignature or it is a fraud or forgery. Follow these steps to validate a document:- 
 
The Validation process is of a digital nature applying a complex mathematical 
algorithm. Follow these steps to validate a document:- 
 

1. Click menu “Document=>Validate” or press F2 on the keyboard. 
2. Select the external document or file to validate. Click “Open” button. 
3. Wait for Validation message/s to return. See figure 24 and 25 below for a 

True and False validation messages respectively. 
 

 
Figure 24 – Validation True 

 
Figure 25 – Validation False 

 

 
Figure 26 – The document does not exist 
 
It is absolutely not possible for the digital validation process to validate and 
process the documents incorrectly. If this happens, it will give another error 
message and not the validation message/s. This is true validation beyond 
reasonable doubt. 
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9.7  Search documents? 
 
Search retrieves the document list as per the document work flow. There are two 
character that can be incorporated into the search criteria:- 

·  Percentage sign (%)  - represents one or more characters 
·  Underscore (_) – represents one character 

 
A Search can be executed using one or a combination of all available text fields. 
Searches can be done by full keywords or partial keywords. Exact phrases can 
be used or multi keywords separated by a (%) sign. For instance, if you type  
“%minist%speech% ” in Description text field, the Minister speech or Ministry 
speech documents will be retrieved. 
 
Figure 27 below contains search criteria to retrieve a list of documents. The text 
fields, Document Number, Description and Expiry Dates were used. In words, it 
means the following “Retrieve all the documents between Document Numbers 70 
and 150 where the document Description contains words ‘contract’ or ‘contracts’ 
or ‘contracted’ and will be expiring between dates 2014/03/01 and 2014/06/30” 
The query will be executed as described above or in figure 27.  
 
Many search queries can be put together by combining the search criteria as 
shown. Remember the result set or list that is returned still complies with the 
document work flow rule that is enforced by the application on all devices. 
 

1. Click the menu “Document=>Search” or Ctrl + S on the keyboard. 
2. Enter your search criteria as illustrated below in figure 27. 
3. Click “Search” button. 
4. The search results will be populated in the new tab “Searched 

Documents”. 
5. Double click any document on the list to retrieve it. The document 

launches or opens in Adobe Reader. 
6. Click the “Refresh” button to reset the list or retrieve the latest data. 

 

 
Figure 27 – Search documents window 
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9.8  Make Payments? 
 
All payments must be made on the Datarizer website on the following link:- 
http://www.datarizer.co.za/payments.htm 
 
Datarizer website will redirect you to a secure payment portal where you can 
finalize your payment. Confirmation email will be sent to the email you have 
provided during the payment process. 
 
If the application locks out or service is denied, the application will provide 
adequate information to enable you to carry out the payment. There is one 
payment process that is applicable to all Datarizer products and services. 
 
The following information must be provided before you are redirected to the 
secure payment portal:- 

1. Firstname, 
2. Surname, 
3. Email address, 
4. Your Registration Number (same as reference number), 
5. Item Name, 
6. Amount (in South African Rands, ZAR). 

See figure 28 below. 
 
The following payment methods are supported:- 

·  VISA Credit Card, 
·  MasterCard Credit Card, 
·  Internet banking (ABSA, FNB, NEDBANK, Standard Bank), 
·  U kash. 

 
Follow this guideline for all payment types for Datarizer eSignature:- 
 
Product or 
service 

Your Registration 
Number Item Name Remarks 

Licence Device Stamp eSignature Once off payment 
Service Days Account Number Service Days Receive 180 Service 

Days or six months. 
Resuscitation Fee Document Number and 

Device Signature. Use as 
provided by the 
application. 

Resuscitation Fee This fee must be paid 
before a “Dead” 
document is retrieved. 
(Document State: 
Dead). All the expired 
documents. 

Excess Data Usage Invoice Number Excess Data After 12 months on the 
anniversary month. 
Data assessment and 
Invoice will be 
submitted. 

 
Payment procedure  (Refer to figure 28 and 29 below) 

1. Go to www.datarizer.co.za/payments.htm and click “PAY NOW”. 
2. Enter the necessary information and click “Submit” button. 
3. You will be redirected to https://www.payfast.co.za (Secure portal) 

a. First time Buyer – Register and Pay. 
b. Returning Buyer – Login and Pay. 

4. Confirmation email will be send to you immediately. 
5. Launch Datarizer eSignature application. All should be back to normal. 
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Figure 28 – The first payment screen 
 

 
Figure 29 – A Secure payment portal for Datarizer Inc. 
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Launch the Application from the 
desktop (Desktop icon). A signing 
pencil. 
 

 
Datarizer eSignature Logo 

 
 
 
 

 

Download Datarizer eSignature  
 
Software certificate was issued by COMODO. https://www.comodo.com 

 
 
 
Down load the software from www.datarizer.co.za/Datarizer_eSignature.htm. 
Click on the download link and follow the download steps as provided. 
Downloading is simple.  
 
There are no complex settings that the user must enter. 
 
Even though you get a Desktop icon to launch the application, Datarizer 
eSignature is a pure internet based application running on the server and a small 
part temporarily running on the client machine. 
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Contact Us 
 
Website: http://www.datarizer.co.za 
 
E-mail:  info@datarizer.co.za or 
   
Contact: Lesley Baloyi 
 
Telephone: +27 11-466-0245 
 
Cell:  +27 72-625-7662 
 
Fax number: +27 86-688-5128 
 
Alternatively contact:  
 
Dade Mbhele on  +27 82 885 0813 
 
 
 

 

Datarizer 


